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Release of Leica iCON office version 2026.1.3

We are pleased to release Leica iCON office, version 2026.1.3. In this version, the focus has been to
improve IFC workflows and 3D graphics. With new graphical IFC selection options and improved IFC
search functionality, it's easier to find and import certain IFC objects for further processing. The fly-
through function in the 3D window has been updated with new features, and the algorithm used to find
the rotation point has been improved.

With the new window, Files in Graphics, small but frequent daily tasks such as turning file visibility on
and off, point/line names and height information, when working with multiple layers of open files, can be
done faster and smoother. Combined with other improvements, such as file and code search in multiple
dialogues, the number of required clicks to perform everyday tasks is significantly reduced.

With the new menu option, "Save Window Layout," the user can save the modified size, width, and
location of different windows, panes, and toolbars as a layout. Multiple window layouts can be saved and

dedicated to different workflows.

All users with valid maintenance will be able to install and run this new version.

Please take your time to read these Release Notes!

The release notes contain important information about the new version of the Leica iCON office software
and application features.
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1 Improvements

1.1 IFC — Improved Workflows

New functionalities to search and find objects in large and heavy IFC models. Both in the graphical
window and in the IFC filter view, several improvements have been added to make it easier to extract
data for both stake-out and data preparation for machine control.
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IFC right-click menu in the graphics and IFC filter view with search settings

1.1.1 IFC Context Menu

If you have been using the select tool and graphics to hide, select or extract objects from AutoCAD
DWG/DXF files, you will recognise the new context menu available for IFC files. Select objects in the
graphics and use the options in the new right-click menu:

= Toggle on/off options:
o Hide selected objects
o Hide non-selected objects
o Hide selected IFC Type(s)
o Hide non-selected IFC Type(s)
= Select options
o Select selected IFC Type(s) objects — All objects of the selected IFC Type or IFC Types
are selected.
o Unselect all
= Show hidden objects - With this option, all hidden objects that are toggled off from the Filter
View or the graphics are visualised again.
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1.1.2 IFC Search in Filter View

The search available in the filter view is improved, and now it's possible to search for any property.
Earlier, only the name, description and IFC type were included in the search.

= To get a more effective search and a limited list of matched results, there are two new settings that
can be used:
o Category - Select all, or which category to include in the search.
o Property - Select all, or which property to include in the search.

In many projects, specific categories or properties are used when identifying objects. With the new
settings above, the search results can be more fine-grained.

When listed objects are selected, the context menu in the filter view is updated with the following
options:

o Hide selected objects

o Hide nonselected objects

o Hide selected IFC Type(s)

o Hide nonselected IFC Type(s)

Filters

Documents 4 K31-1512-20-B0000-V0-4031_241216.ifc x] [

@3 K31-1512-20-B0000-V0-4031_241216.ifc Display mode
@B K31-1512-20-B0000-V0-4041_250121.ifc

Search objects Category FUT 3 ~ Property Al ~
Types ~ GC11

= fcSlab fficSlab

ffcSlab -
Save Selection
Save Selection as AutoCAD
Hide Selected Objects
Hide Monselected Objects
Hide Selected IFC Type(s)

Hide Nonselected IFC Type(s)

Type On Mame Description Found in

Files in Graphics Attributes  Cross Section Preview Processes

IFC Filter View — Search result for the search GC11 and it is found in a property called Prefix.

1.1.3 Extract IFC Solids as Surfaces

Two improvements have been made for the option to generate surfaces, highest or lowest level, of
selected IFC solids.

= Merge — A new setting in the IFC workflow view.

o If activated and multiple solids are selected, the extracted surfaces are merged into one
surface file (*.trm).

o If not selected, an individual surface file for every solid is created, even if multiple solids are
selected.

Save selection as AutoCAD — Improvements when saving selected IFC objects to a DWG file.

o If the option, Extract solids as surfaces, is used and selected, IFC objects are saved directly
to AutoCAD format, and the objects are now saved as 3D faces in the DWG file.

o If the option, Extract solids as surfaces, is not activated, the selected IFC objects are saved
as 3D polylines in the DWG file.
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Selected objects saved as 3D poly lines and 3D face in DWG files.

1.2 3D Graphic

1.2.1 3D Window - Updated Fly Through

The function to fly through a model using a road line as fly path is improved and easily accessible by a
shortcut icon next to the active reference line, at the bottom of the 3D window.

The fly-through dialogue is updated with more settings:

= Start and end station — The fly path can be limited by changing the start and end station of the
used line

= Pause control is added so the visualisation can be temporarily stopped at interesting sections.

=  Options to manually step forward and backwards.

=  The current station information can be displayed both in the dialogue and the graphical window.
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View direction: Fly height:

© along fly path O Offset from profile: 3,000
() At fixed point () Fixed height: 0,000
X 0,000
pie 0,000

z: 0,000

Play settings:

[JReverse
[JRepeat.

{8 Display current station in graphics  Current station:  0/258,000
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T

Fly-through along a road line in an IFC model

T616AACOI3d 3
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1.2.2 3D Window - Rotation Centre

Improved algorithm for how the centre of rotation in 3D window is defined for surface and line objects in
the following formats:

= TRM, DWG/DXF, IFC and LandXML
o Ifthe cursor is held over an object, when the mouse button or the space-bar is pressed,
that object and its height decide the rotation centre.

o If no object is found, the rotation centre is determined like today i.e., at the centre of all
visible objects.

= For other file formats, the rotation centre is defined as the centre of all visible objects.

1.3 Files in Graphics

New window, Files in Graphics, to manage open files in graphics and it will replace the old modal
dialog, Document in Graphical View.

= Dock able window - The user can decide where the window should be placed to have good
accessibility when working. It could even be displayed on a separate screen.

= Non-modal window - The window is not blocking the application, so the user can continue to
interact with e.g. the graphic window.

Files in Graphics

Open files... Cloze files Properties... [CIFile paths Lk H_J] Symbol paper scale: 1000

Type Color ©On 123
| '\5‘. House Pad_sub.geo x
\\» Excavation Trench 1.trm.geo
\X Polygon.geo
'\5‘. Main FipesProfiles 3.qe0
& STrench _Services.trm
[ Red_Existing Surface_0_S.trm

+ ot ot
ETE S B B |
+ _+ _+|_+ @

[FICAGEE LIS Attributes  Cross Section Preview  Filters  Processes

Files in Graphics — Default position is in the bottom right corner.

From Files in Graphics, you have easy access to:

Close files by using either the X symbol or the buttons.
Open additional files in the active graphical window.
Toggle file visibility on/off.

Turn point/line information on/off.

Change active file by double-clicking on a file name.
Change the drawing order of files in 2D window.

while you still can have access to the application and the graphical window.

1.4 File Search in Dialog

Search functionality has been added to several dialogs to make it easier and faster to select input files,
instead of using the browse option.

Instant search and matched results are highlighted.

Filter — Only files of the expected file type(s) are listed.

All files available in the project folder and its subfolders are included in the search.
The list of files found is sorted based on matched percentage.
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*, E45 As Built 700-1200_OK.geo
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Heights “ E45_201-5_140_Sub-Base.geo

O Terrain Model

() Terrain Model - Cog

(_) Coordinate file - Te

I
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Add height constant: 0,000

Mo limits

Define limits

Points outside model
O Leave unchanged

() Delete paint
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File search in a dialog with highlighted matched results.

1.5 Code Search

If a code list is selected for the active project, search functionality is available in the dialogs, Select Point
Code and Select Line Code. The code list is defined in project settings and can be opened from File >
Open active Code List.

= ltis possible to search by code, | Select line code 7 X
description or layer. | Code:
Search by code, description and layer b |
= Instant search and matched results are | oo [ |
h|gh||ghted Select line code ? *
Line Type: Mo Lil
Code:
, . . M Pl “
= |t's still possible to add any code oK 113 - PR Layer: MI107030
. . 418 - Sewage pipe Layer: MI172100
manually i.e., even a code not available 428 - Drainage pipe Layer: MI172200
. . . 433 - Water pipe Layer: MI171000
in the active code list. 448 - Pipe bend Layer: MI173510

458 - Gas pipe Layer: MI170000
566 - PVT pipe Layer: MI112001

Code search and highlighted results

1.6 Save Window Layout

In Leica iCON office it is possible to move and resize different windows, views/panes and toolbars
depending on what is most suitable for the current workflow and personal preferences. The Window
menu is updated with three more options, so the user can create, save and manage multiple user-
defined window layouts, instead of modifying them every time they do a specific workflow.

= New options:
o Save Window Layout — The current window layout is saved with any name i.e., the
current size, width and location of all windows, panes and toolbars are saved.
o Apply Window Layout — Select active layout from a list of all saved layouts.
o Manage Window Layout — Possible to rename or delete already saved layouts.
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= Restore Window Layout - The restore function is improved and includes even toolbar layout
and width of project tree, workflow and other views etc.

Full Screen

Save Window Layout

Apply Window Layout » ConX-Left Side

Manage Window Layouts... Files in Graphic-5Separate
Reset Window Layout Files in Graphic-Top
IFC

Test
Menu options to save and manage layouts, and in the screenshot, 5 layouts are saved.

1.7 AutoCAD
=  The property dialog for DWG/DXF files is updated with the following options:

o New options to add and delete layers.
= If layers are deleted, the user will get a chance to delete layer AND all entities
linked to it.
o Bold font is used for current layer.
o Layer name is automatically displayed in tooltip, if the name column doesn't fit the full

layer name.
AutoCAD® Drawing Properties ? X
Property Page  General \
[Number of layers: 72 Jcurrent Layer: PLATAFORMA|LINEASROTURA | Add Delete Rename
Name On Freeze lock  Color  Linetype Line Weight Plotstyle  Plot InUse  Desaription
PLATAFORMA|CAB & o 7 contruous Default Color_7 Plot No
PLATAFORMA|CODIGOS (S = . 7 Continuous Default Calor_7 Plot. No
PLATAFORMA|COTAS A o [l contruous Default Color 20 Plot No
PLATAFORMA |CURVADC b o [lls4 contruous Default Color 54 Plot Mo
PLATAFORMA FORMATO & o 5 Contuous Default Color_5 Plot No
PLATAFORMA |LINEASMDT 6 & . 47  Continuous Default Color_47 Plot. No
PLATAFORMA | LINEASR... A ' [ 20 Continuous  Default Color_ 20  Plot  HNo
PLATAFORMA|LOGO 7 Continuous Default Color_7 Plot Mo
PLATAFORMA |[MAESTRS = 34 Continuous Default Color 34 Plot No
PLATAFORMA NUMEROS & o []13t Contiuous Default Color_131  Plot No
PLATAFORMAPPUNTOS & o 7 contruous Default Color_7 Flot Mo
PLATAFORMA |PPUNTOSE... A = . 7 Continuous Default Color_7 Flot Mo
PLATAFORMA JPUNTOS3D & = . 7 Continuous Default Color_7 Plot Mo
PLATAFORMA |RED BASES ry o W7 contruous Default Color_7 Plot No
PLATAFORMA |SCURVADO & o 54 Contiuous Default Color_54  Plot No
PLATAFORMA|SMAESTRAS (S = . 34 Continuous Default Color_34 Plot. No
PLATAFORMA|SOMBRAS A = . 20 Continuous Default Color_20 Flot Mo
PLATAFORMA[TEXTOS & o 7 contruous Default Color_7 Flot No
Select All Select... Invert Selections Update Changes Instantly @ Updat=
oK Cancel Help

File properties for CAD files with updated functionality to add and remove layers.
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= AutoCAD files, with broken path to attached Xref file, can now be fixed if the user has access to
the Xref file.

o Select Data > External References, and in the visualised dialogue, it's possible to
edit and fix broken Xref paths.

| %< Bef Ledningar 210803.dwg X |
| MR - BefLedningar 210803.dwg ad F

® ESRI World Imager v | % s 2 & 'q

/ #y
External References (Xrefs) in the AutoCAD file X

Reference Name  Status Size Type Date Saved Path Attach...
Bef_VA_ledning... Loaded Attach C:\Users'\Public\Docu. .. Detach
A3003040 Not found Attach C:\Users'\Public\Doau...

Reload

Unload

Bind

Xref path

C:\Users'\Public\Documents\Sbg\Projects\ByPass STHLM FSE 105\43003040.dwg
Cancel Help

Dialogue to edit external references.

1.8 LandXML Export

= Translation of exported attributes - Points and lines can have attributes included in the export
and if the new option, Translate exported attributes, is activated and an attribute file (*.atr) is
selected in project settings, the attributes are formatted and translated according to descriptions
available in the active attribute file.

Import/Expart files 7 X
Local Files LandXML-files
FwaoXE Pre® draxXE Teow
C:\Wsers'Public\Documents'Sba\Projects\SBG T-SITE SWERE @ C:\WUsers'Public\Documents'Sbg\Projects\SBG T-SITE SWERE @
MName Ext  Date | Size| | Mame | Ex? Date Size
S Perimeter Surveyed LandXML Settings %
| 3KB
Select LandXML schema extension for export 4KB

Active file: Perimeter 5

Select active file to exp| © Mo extension ke
exported as well, 310
() HeXML (for colors and other additional information) 8KB

(150 151434 3KB

185KB

B Translate exported attributes
- Attributes will be translated and formatted using the attribute definition file (ATR)
- Code description and layer from code list will be added as atiributes

Care

[N

8 Multiple Graphic preview in same window << Transfer Transfer == Close Help

LandXML export settings
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= 1SO LandXML Export - The ISO schema is strict when it comes to duplicated names. A single
point is not allowed to have the same ID/name as a line. New functionality to auto-resolve name
conflicts between objects when exporting point and line data to ISO LandXML and DBX is
implemented.

1.9 Coordinate Files — Water Flow Direction

= Water flow direction — A new option to turn on a symbol to visualise flow direction for 3D lines.
The setting can be toggled on in document properties for coordinate files.

[ *¢ Main Pipes| 3.ge0 x
| W', TestSTrenchiMain PipesProfiles 3.ge0 V| S |?EESPI World Street V| % |tz

Main scale

1 z s ‘

(W] (TR ¥ | v 4 No line reference »

Lines with water flow direction turned on.

1.10 Terrain Model

= |f a terrain model has a surface colour saved to file, the same colour is now used as identification
colour, e.g. the colour used in Files in Graphics and as layer colour in Cross Section Preview.

= O3 - soe |2 X FRRAIRKARKE O &

ROADCL 71

] Offset=0,39 He192,55467

o/o78
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Cross section preview

= Difference model — If the model is visualised in point mode instead of as a surface, the points
are displayed with selected cut and fill colours.

. Diff_AsBuilt_RaceTrack.dfm x|

(W5 Diff_Ashuit RaceTrackdfn [ [ e word street - % {a PAE R

Main scale

z0 50

Difference Modsl Properties 7 X

| Difference colors.

| s N |
= [ ~|
i [ -

Display settings

Surface mode. Hane
Distance: Custom:
Cantour fnes o

Shaw breakdines. O] [ ]
Shaw ponts ] L] o| s 2

Transparency

Properties far
(OFie type defadt
© This window

o | Cancel e

[N 9] [FRWIR-2F [lojine reference " Slope 1,268% in Direction 230, 1833

q Plane
The difference model is displayed with points in cut and fill colours.

2 Bug Fixes and Maintenance

= New installation - Not possible to create a new project, if the active project couldn’t be read or if it
was a new installation with no available projects. The application would stop working. Fixed

= Files in Graphics - Send backward did not work as expected. Fixed

= 3D graphics - Zoom with mouse wheel, when height was distorted, caused some issues. Fixed

=  Crop Terrain Model - Crop model with a concave polygon; some gaps were observed. Fixed

= TS20 is added to the list of known total stations and the values for atmospheric correction are set
accordingly.

= Help Text — The manual (select Help > Help Topics...) is updated with information on how to add
images and screenshots to reports.

=  Tunnel - Default colours for TDM are updated.

= Attribute list - The 20-character limit for Attribute Type and Description is removed, and the
default width for both columns is increased.

= Length report - The report ignores points if special code R is used without a remark value added.
Fixed

= Point symbols had different orientations in 2D and 3D windows. Fixed

= In the numerical view, the point code description was missing if a point code started with a dash.
Fixed

= LandXML export - Line attributes were duplicated to next line. Fixed
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3 Leica iCON office Licensing

3.1 Article Numbers

Leica iCON office starts with Core, which enables import/export of data, 3D visualisation, COGO
calculations, coordinate system handling, visualisation in Google Earth and generating drawings, etc.

Base Software

971847 | iCON office Core It features import/export and COGO functionality and can
be upgraded with various options.

Options

971848 | iCON office Road iCON office Core is required for upgrading.

971849 | iCON office Terrain iCON office Core is required for upgrading.

971854 | iCON office Trench iCON office Core and Terrain are required for upgrading.

971853 | iCON office Point Cloud iCON office Core and Terrain are required for upgrading.

971850 | iCON office Volume iCON office Core, Road and Terrain are required for
upgrading.

971851 | iCON office Tunnel iCON office Core, Road and Terrain are required for
upgrading.

971852 | iCON office Net Adjustment | iCON office Core is required for upgrading.

CCP

6017858 | 1yr iCON office CCP iCON office CCP extended one year

6017859 | 2yr iCON office CCP iCON office CCP extended two years

6017860 | 3yr iCON office CCP iCON office CCP extended three years

Migration

971913 | iCON office Migration Migration from dongle to EIDs. Valid CCP is required.

Re-activation

5311599 | Re-activation Fee iCON Re-activation Fee iCON office (>1yr) applied if

office (>1yr) maintenance expired for +365days

4 Leica myWorld

Please use Leica myWorld to find the latest version of iCON office. m yWO r ld

=  myWorld >> my Downloads >> iCON >> iCON office by using the
following link: https://myworld.leica-geosystems.com/
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